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1
Computer Diagnostic Features

Compaq Diagnostics for Windows
The Compaq Diagnostics for Windows (DFW) utility is a component 
of Intelligent Manageability that allows you to view information 
about the hardware and software configuration of your computer 
while running Microsoft Windows (Microsoft Windows 98, 
Microsoft Windows Me, Microsoft Windows 2000, Microsoft 
Windows NT 4.0, and Microsoft Windows XP). It also allows you to 
perform hardware and software tests on the subsystems of your 
computer.

When you invoke Diagnostics for Windows, the Overview screen is 
displayed, which shows the current configuration of the computer. 
From the Overview screen, there is access to several categories of 
information about the computer and the Test tab. The information in 
every screen of the utility can be saved to a file or printed.

✎ To test all subsystems, you must log in as the administrator. If you do 
not log in as the administrator, you will be unable to test some 
subsystems. The inability to test a subsystem will be indicated by an 
error message under the subsystem name in the TEST window or by 
shaded check boxes that cannot be selected.
Troubleshooting Guide 1–1
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Menu Bar—File, Categories, Navigation, Level, Tab, Help

At the top of the Compaq Diagnostics for Windows screen is the 
Menu Bar consisting of six pull-down menus:

■ File—Save As, Print, Printer Setup, Exit

■ Categories—See the list of categories in the following section

■ Navigation—Previous Category (F5), Next Category (F6)

■ Level—Less (F7), More (F8) <information on the screen>

■ Tab—Overview, Test, Status, Log, Error

■ Help—Contents, How to use Help, About

ToolBar—Icons for Different Categories of Information

Below the Menu Bar is a row of icons for each of the following 
categories of information about the computer:

■ System—System board, ROM, date, and time information

■ Asset Control—Asset tag, system serial number, and processor 
information

■ Input Devices—Keyboard, mouse, and joystick(s) information

■ Communication—Ports in system and information about each

■ Storage—Storage drives in system and information about each

■ Graphics—Graphics system information

■ Memory—System board and Windows memory information

■ Multimedia—Optical storage (CD, DVD, and so on) and audio 
information

■ Windows—Windows information

■ Architecture—PCI Device information

■ Resources—IRQ, I/O, and Memory Map information

■ Health—Status of system temperature and hard drives

■ Miscellaneous—CMOS, DMI, BIOS, System, Product Name, 
and Serial Number
1–2 Troubleshooting Guide
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Tabs—Overview, Test, Status, Log, Error

Below the ToolBar are five tabs:

■ Overview—The Overview window displays general overview 
information about the computer. This is the window that is 
displayed when you first start the utility. The left side of the 
window shows hardware information, and the right side of the 
window shows software information.

■ Test—The Test window allows you to choose various parts of 
the system to test. You can also choose the type of test and 
testing mode.

■ Status—The Status window displays the status of each test in 
progress. You can cancel testing by clicking the Cancel Testing 
button.

■ Log—The Log window displays a log of tests for each device.

■ Error—The Error window displays any errors that occurred 
during device testing. The window lists the device being tested, 
the type and number of errors, and the error code.

Installing Compaq Diagnostics for Windows

This operation is required only if the diagnostics program software 
has been loaded on the hard drive but not installed.

1. Close any Windows applications.

2. Double-click the Compaq Diagnostics for Windows icon, 
located on the Windows Desktop.
Troubleshooting Guide 1–3
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3. Click Next to install Compaq Diagnostics for Windows.

4. After the program has finished installing, you may be prompted 
to restart the computer, or it may automatically restart. If 
prompted, click Finish to restart the computer or Cancel to exit 
the program. You must restart the computer to complete the 
installation of Compaq Diagnostics for Windows.

✎ If you want to upgrade an existing version of Compaq Diagnostics 
for Windows installed on your computer, visit 
www.compaq.com/support/files and click on an applicable product. 
In the next window, find Option 2—Locate by Category. Select 
Management Applications and Utilities. Click Locate Software 
and download the latest version. Execute the downloaded file and 
select Repair to update the installed version. This will cause the new 
version to overwrite the old version.

Using Categories in Compaq Diagnostics for Windows

To use the categories do the following:

1. Click Start > Compaq Information Center > Compaq 
Diagnostics for Windows. You can also select the Compaq 
Diagnostics for Windows icon, located in the Control Panel.

The screen displays the overview of the computer hardware and 
software.

2. For specific hardware and software information, select a category 
from the Categories pull-down menu or the appropriate icon on 
the toolbar.

✎ As you move your cursor over the toolbar icons, the corresponding 
category name displays near the cursor.

3. To display more detailed information in a selected category, click 
More in the Information Level box in the lower left corner of the 
window or click Level at the top of the screen and select More.

4. Review, print, and/or save this information as needed.
1–4 Troubleshooting Guide
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✎ To print the information, click File, then select Print. Select one of 
the following options: Detailed Report (All Categories), Summary 
Report (All Categories), or Current Category. Click OK to print 
the report you selected.

✎ To save the information, click File, then select Save As. Select one of 
the following options: Detailed Report (All Categories), Summary 
Report (All Categories), or Current Category. Click OK to save 
the report you selected.

5. To exit Compaq Diagnostics for Windows, click File, and then 
click Exit.

Running Diagnostic Tests in Compaq Diagnostics for 
Windows

To run diagnostic tests:

1. Click Start > Compaq Information Center > Compaq 
Diagnostics for Windows. You can also select the Compaq 
Diagnostics for Windows icon, located in the Control Panel.

The screen displays the overview of the computer hardware and 
software. Five tabs are displayed below the row of icons: 
Overview, Test, Status, Log, and Error.

2. Click the Test tab, or click Tab at the top of the screen and 
select Test.
Troubleshooting Guide 1–5
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3. Select one of the following options:

❏ Quick Test—Runs a quick, general test on each device. 
Requires no user intervention if Unattended Mode is selected.

❏ Complete Test—Runs maximum testing of each device. The 
user can select Interactive Mode or Unattended Mode.

❏ Custom Test—Runs only the tests you select. To select 
specific devices or tests, find the device in the list, then select 
the check box beside each test. When selected, a red check 
mark is displayed in the box. Some tests selected may require 
user intervention.

✎ To test all subsystems, you must log in as the administrator. If you do 
not log in as the administrator, you will be unable to test some 
subsystems. The inability to test a subsystem will be indicated by an 
error message under the subsystem name in the Test window or by 
shaded boxes that cannot be checked.

4. Select Interactive Mode or Unattended Mode. In Interactive 
Mode, the diagnostic software will prompt you for input during 
tests that require it. Some tests require interaction and will 
display errors or halt testing if selected in conjunction with 
Unattended Mode.

5. Click the Begin Testing button at bottom of window. Test Status 
is displayed, showing the progress and result of each test. For 
more details on the tests run, click the Log tab or click Tab at the 
top of the screen and select Log.

6. If errors are found, click the Error tab to display more detailed 
information and recommended actions. By following the 
recommended actions, you may be able to solve some problems 
yourself.

7. Click Print or save the error information in case you need to 
contact your Compaq authorized dealer, reseller, or service 
provider for assistance.

8. To exit Compaq Diagnostics for Windows, click File, then 
click Exit.
1–6 Troubleshooting Guide
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Compaq Configuration Record Utility
Compaq Configuration Record Utility is a windows-based 
information-gathering tool similar to other Compaq management 
tools. It gathers critical hardware and software information from 
various computer subsystems to give a complete view of your desktop 
or workstation. Configuration Record Utility provides a means for 
automatically identifying and comparing configuration changes, and 
has the ability to maintain a configuration history. The information 
can be saved as a history of multiple sessions.

This utility was developed to allow resolution of problems without 
taking the desktop or workstation offline and to assist in maximizing 
the desktop or workstation availability. The information obtained 
by the utility is useful in troubleshooting system problems, and 
streamlines the service process by enabling quick and easy 
identification of system configurations, which is the first step 
in resolving service cases.

The Compaq Configuration Record Utility gathers information 
automatically on the hardware and operating system software to 
deliver a comprehensive view of the system. It gathers information 
on such items as the ROM, asset tag, processor, physical drives, 
PCI devices, memory, graphics, operating system version number, 
operating system parameters, and the operating system startup files 
and displays it. If the original Base.log file is present in the cpqdiags 
directory, the Base.log file is displayed next to the Now.log file in a 
split window with the differences between the two highlighted in the 
color red.

Running Configuration Record Utility

To run this program:

1. Click Start > Compaq Information Center > Compaq 
Configuration Record. You can also select the Compaq 
Configuration Record icon, located in the Control Panel.
Troubleshooting Guide 1–7
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✎ The Compaq Configuration Record Utility has two view options: 
Show Changed Items Only and Show All. The default view is Show 
Changed Items Only, therefore all the text is displayed in the color 
red since it shows only the differences. Switching to Show All 
displays the complete, comprehensive view of the system.

✎ The Compaq Configuration Record Utility is part of Compaq 
Diagnostics for Windows. Whenever you upgrade Compaq 
Diagnostics for Windows, the Compaq Configuration Record Utility 
is also upgraded.

2. The default view is Show Changed Items Only. To view all the 
information gathered by Compaq Configuration Record, click 
View at the top of the window and select Show All, or click the 
Show All Items icon.

3. To save the information in the left or right window, select File > 
Save Window File and then select Left Window File or Right 
Window File.

✎ Saving the configuration of the computer periodically allows the user 
to keep a history of the configuration. This history may be useful to 
your service provider if the system ever encounters a problem that 
needs debugging.

4. To exit Compaq Configuration Record, click File, then click Exit.

Compaq Remote Diagnostics Enabling Agent
This utility was developed to allow faster resolution of problems 
without having to visit a site and take the computer offline and to 
assist in maximizing computer availability. The information obtained 
by the utility is useful in troubleshooting computer problems, and 
streamlines the service process by enabling quick and easy 
identification of computer problems.

✎ The Compaq Remote Diagnostics Enabling Agent only works if 
Diagnostics for Windows is also installed.
1–8 Troubleshooting Guide
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The Compaq Remote Diagnostics Enabling Agent provides a Web 
browser interface to Compaq Diagnostics for Windows. This enables 
remote control of the diagnostics and facilitates easy transfer of 
computer information from remote machines to a service provider.

The Compaq Remote Diagnostics Enabling Agent captures hardware 
configuration and provides the ability to perform tests remotely to 
diagnose computer problems. In addition, the Compaq Remote 
Diagnostics Enabling Agent identifies any computer hardware device 
problems signaled by the Compaq DMI management agents. These 
hardware devices are automatically selected for testing by the 
Compaq Remote Diagnostics Enabling Agent.

Use of Compaq Remote Diagnostics Enabling Agent reduces the time 
and effort needed to perform hardware diagnostic tasks. By allowing 
the service personnel direct access to computer hardware diagnostic 
tools, the Compaq Remote Diagnostics Enabling Agent delivers a 
view of the computer hardware devices and the tests available to 
isolate hardware problems with the ease and simplicity of a single 
tool. This approach minimizes problem resolution time, and also 
minimizes administration resources because less time is spent visiting 
a site or communicating with a user over the phone to resolve 
computer hardware problems when they do occur.

✎ The Compaq Remote Diagnostics Enabling Agent was designed 
to work in the Compaq Insight Manager LC environment. It is 
pre-loaded on most commercial desktops and workstations and 
is available through a SoftPaq at www.compaq.com under 
Management Applications and Utilities.

Starting the Remote Diagnostics Enabling Agent

1. Select the Compaq Remote Diagnostics icon located in the 
Control Panel.

✎ The Compaq Remote Diagnostics Enabling Agent allows you to run 
Diagnostic Test or the Configuration Record Utility in a browser 
window. Both of these utilities can be run remotely or locally.

2. To exit Compaq Remote Diagnostics, click File and then click 
Close.
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Protecting Your Software
To protect software from loss or damage, you should keep a backup 
copy of all system software, applications, and related files stored on 
the hard drive. See the operating system or backup utility 
documentation for instructions on making backup copies of data files.

Restoring Your Software
The operating system and software can be restored to its original state 
as when you purchased the computer by using your Compaq Restore 
Kit. See your Compaq Restore Kit for complete instructions on using 
this feature.
1–10 Troubleshooting Guide
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2
Troubleshooting Without Diagnostics

This guide provides information on how to identify and correct 
minor disk, graphics, memory, and software problems. It also 
explains many of the messages that may be displayed on the screen, 
including specific error messages that may appear during the 
Power-On Self-Test (POST) at startup.

POST Message Disabled suppresses most system messages during 
POST, such as memory count and non-error text messages. In this 
mode, the Compaq logo and Web address appear on the computer 
monitor. If a POST error occurs, the screen will display the error 
message. To manually switch to the POST Messages Enabled mode 
during POST, press any key (except F10 or F12). The default mode is 
POST Message Disabled.

The speed at which the computer loads the operating system and the 
extent to which it is tested are determined by the POST mode 
selection.

Quick Boot is a fast startup process that does not run all of the system 
level tests, such as the memory test. Full Boot runs all of the 
ROM-based system tests and takes longer to complete.

Full Boot may also be enabled to run every 1 to 30 days on a regularly 
scheduled basis. To establish the schedule, reconfigure your computer 
to the Full Boot Every x Days mode, using Computer Setup.

✎ For more information on Computer Setup, see the Computer Setup 
(F10) Utility Guide.
Troubleshooting Guide 2–1



Troubleshooting Without Diagnostics

177620-006.book  Page 2  Thursday, March 14, 2002  3:16 PM
Helpful Hints
If you encounter some minor problems with your computer, monitor, 
or software, see the following list of general suggestions before taking 
further action:

■ Check that the computer and monitor are plugged into a working 
electrical outlet.

■ Check to see that the computer is turned on and the green power 
light is on.

■ Check to see that the monitor is turned on and the green monitor 
light is on. 

■ Turn up the brightness and contrast controls of the monitor if the 
monitor is dim.

■ Press and hold any key. If the system beeps, then your keyboard 
should be operating correctly.

■ Check all cable connections for loose connections or incorrect 
connections.

■ Reconfigure your computer after installing a non–plug and play 
expansion board or other option. See “Solving Hardware 
Installation Problems” for instructions.

■ Be sure that all the needed device drivers have been installed. For 
example, if you are using a printer, you need a driver for that 
model printer.

■ Remove all diskettes from your system before turning it on.

■ If you have installed an operating system other than the 
factory-installed operating system, check to be sure that it is 
supported on your system.

■ If your system has an AGP card installed (on select models only), 
the monitor must be plugged into the monitor connector on the 
AGP card. The other monitor connector is disabled and if the 
monitor is connected into this port, the monitor will not function.

Ä
CAUTION: When the computer is plugged into an AC power source, 
there is always voltage applied to the system board. You must 
disconnect the power cord from the power source before opening the 
computer to prevent system board or component damage.
2–2 Troubleshooting Guide
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Solving General Problems
You may be able to easily resolve the general problems described in 
this section. If a problem persists and you are unable to resolve it 
yourself or if you feel uncomfortable about performing the operation, 
contact your Compaq authorized dealer or reseller.

Solving General Problems

Problem Cause Solution

Computer won’t 
turn on.

Computer is not 
connected to an external 
power source.

Connect to an external power 
source.

Cables to the external 
power source are 
unplugged.

Ensure that cables connecting the 
computer to the external power 
source are plugged in properly and 
the wall outlet is active.

A defective PCI card has 
been installed.

Remove any expansion board that 
was just installed.

Drive power, data, or 
power supply cables 
may not be properly 
connected.

Reseat drive power, data, and power 
supply cables.

Power line selector 
switch on rear of 
computer chassis not 
switched to correct line 
voltage (115V or 230V) 
(some models).

Select the proper AC voltage using 
the slide switch.

Computer appears 
locked up and won’t 
turn off when the 
power button is 
pressed.

Software control of the 
power switch is not 
functional.

Press and hold the power button for 
at least 4 seconds until the computer 
turns off.
Troubleshooting Guide 2–3
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Computer date and 
time display is 
incorrect.

RTC (real-time clock) 
battery may need to be 
replaced. Battery life is 
approximately 3–5 years.

First, reset the date and time under 
Control Panel (Computer Setup 
can also be used to update the 
RTC date and time). If the problem 
persists, replace the RTC battery. 
See the Hardware Reference Guide 
for instructions on installing a new 
battery, or contact your Compaq 
authorized dealer or reseller for RTC 
battery replacement.

Computer powered off 
automatically and the 
Power LED is:

1. Flashing Red or 
Yellow four times 
per second, OR

2. Flashing Red or 
Yellow two times 
one second apart, 
followed by a two 
second pause, OR

3. Not flashing.

The unit temperature was 
exceeded. A fan may be 
blocked or not turning. 
OR the heatsink is not 
properly attached to the 
processor.

1. Unit is in an exceedingly hot 
environment. Let it cool down.

2. Ensure computer air vents are 
not blocked and internal fans are 
running (such as the power 
supply fan, chassis fan, and/or 
the processor fan).

3. Ensure heatsink is properly 
seated.

4. Contact Compaq authorized 
reseller or service provider.

The unit temperature was 
exceeded because the 
computer was functioning 
with the cover or access 
panel removed.

Replace cover or access panel, and 
let the computer cool down before 
attempting to turn on power to the 
computer.

Air Baffle (if required) is 
not installed properly to 
redirect air flow over 
processor.

Reseat Air Baffle per instructions in 
the Hardware Reference Guide.

Processor or system fan 
has failed.

Contact a Compaq authorized 
service provider to replace the 
processor or system fan.

Solving General Problems (Continued)

Problem Cause Solution
2–4 Troubleshooting Guide
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Computer appears to 
pause periodically.

Network driver is loaded 
and no network 
connection is 
established.

Establish a network connection, or 
use Computer Setup or Microsoft 
Windows Device Manager to disable 
the network controller.

Cannot remove 
computer cover or 
access panel.

Smart Cover Lock, 
featured on some 
computers, is locked.

Unlock the Smart Cover Lock using 
Computer Setup.

The Smart Cover FailSafe Key, a 
device for manually disabling the 
Smart Cover Lock, is available from 
Compaq. You will need the FailSafe 
Key in case of forgotten password, 
power loss, or computer malfunction.

Poor performance is 
experienced.

Processor is hot. 1. Make sure the airflow to the 
computer is not blocked.

2. Make sure the fans are 
connected and working properly 
(some fans only operate when 
needed).

3. Make sure the processor 
heatsink is installed properly.

Cursor will not move 
using the arrow keys 
on the keypad.

The Num Lock key 
may be on.

Press the Num Lock key. The 
Num Lock light should not be on if 
you want to use the arrow keys.

Solving General Problems (Continued)

Problem Cause Solution
Troubleshooting Guide 2–5
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Solving Power Supply Problems

Solving Power Supply Problems

Problem Cause Solution

Computer won’t turn on 
(Power LED on front of 
computer not on).

Computer is not 
connected to an 
external power source.

Connect to an external power 
source.

Cables to the external 
power source are 
unplugged.

Ensure that cables connecting the 
computer to the external power 
source are plugged in properly 
and the wall outlet is active.

Power switch not 
connected to the 
system board 
(supported on select 
models only).

Plug the power switch cable into 
the system board.

Power line selector 
switch on rear of 
computer chassis not 
switched to correct line 
voltage (115V or 230V) 
(some models).

Select the proper AC voltage using 
the slide switch.

Wall outlet is defective. Test the outlet by connecting a 
different electrical device to the 
outlet.

Power LED flashes Red or 
Yellow every 2 seconds on 
most models.

Power supply 
overloaded or short 
was detected.

Unplug computer from AC power. 
Unplug internal power cables from 
all devices and unplug all PCI 
cards. Reconnect devices one at 
a time and turn power on to identify 
the cause.

Diskette drive power 
cable not properly 
connected.

When installing power cable to 
diskette drive, ensure that all 4 pins 
on the drive are connected to the 
power cable connector.
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Power LED flashes Red or 
Yellow every 2 seconds on 
most models. (continued)

Power supply shuts 
down after system 
warms up. Thermal 
overload caused by 
bad fan.

Replace power supply.

Power supply will not 
turn on because of 
internal power supply 
fault.

Replace power supply.

Power supply shuts down 
intermittently.

Power line selector 
switch on rear of 
computer chassis not 
switched to correct line 
voltage (115V or 230V) 
(some models).

Select the proper AC voltage using 
the slide switch.

Power supply will not 
turn on because of 
internal power supply 
fault.

Replace power supply.

Computer powered off 
automatically and the 
Power LED is:

1. Flashing Red or Yellow 
four times per second, 
OR

2. Flashing Red two 
times one second 
apart, followed by a 
two second pause,
OR

3. Not flashing.

The unit temperature 
was exceeded. A fan 
may be blocked or 
not turning, OR the 
heatsink is not properly 
attached to the 
processor.

1. Unit is in an exceedingly hot 
environment. Let it cool down.

2. Ensure computer air vents are 
not blocked and internal fans 
are running (such as, the 
power supply fan, chassis fan, 
and/or the processor fan).

3. Ensure heatsink is properly 
seated.

4. Contact Compaq authorized 
reseller or service provider.

Solving Power Supply Problems (Continued)

Problem Cause Solution
Troubleshooting Guide 2–7
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Solving Diskette Problems
Common causes and solutions for diskette problems are listed in the 
following table.

✎ You may need to reconfigure the computer when you add or remove 
hardware, such as an additional diskette drive. See “Solving 
Hardware Installation Problems” for instructions.

Solving Diskette Problems

Problem Cause Solution

Diskette drive light 
stays on.

Diskette is damaged. In Microsoft Windows 98 run 
ScanDisk. Click Start > 
Programs > Accessories > 
System Tools > ScanDisk.

In Microsoft Windows 2000, 
Microsoft Windows NT, and 
Microsoft Windows XP, right-click 
Start, click Explore, and select a 
drive. Select File > Properties > 
Tools. Under Error-checking, click 
Check Now.

Diskette is incorrectly 
inserted.

Remove diskette and reinsert.

Drive button is not 
pushed in.

Push in drive button.

Files on diskette are 
damaged.

Check the program diskettes.

Drive cable is not 
properly connected.

Reconnect drive cable.

Drive not found. Cable is loose. Reseat diskette drive data and 
power cable.

Removable drive is not 
seated properly.

Reseat the drive.
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Drive not found. 
(continued)

You attempted to hot 
plug a removable 
hard drive that has 
DriveLock security 
enabled. (This feature 
supported on select 
models only.)

Shut down Windows and turn off 
the computer. Insert the drive into 
the MultiBay, if it is not already 
inserted. Turn on the computer.

Diskette drive cannot write 
to a diskette.

Diskette is not 
formatted.

Format the diskette.

Diskette is 
write-protected.

Use another diskette or remove the 
write protection.

Writing to the wrong 
drive.

Check the drive letter in your path 
statement.

Not enough space is 
left on the diskette.

Use another diskette.

Diskette write control is 
enabled.

Use Computer Setup to check 
your storage security feature 
disabled settings.

Diskette is damaged. Replace the damaged disk.

Cannot format diskette. Invalid media reported. When formatting a disk in DOS, 
you may need to specify diskette 
capacity. For example, to format a 
1.44-MB diskette, type the following 
command at the DOS prompt:

FORMAT A: /F:1440

Solving Diskette Problems (Continued)

Problem Cause Solution
Troubleshooting Guide 2–9
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A problem has occurred 
with a disk transaction.

The directory structure 
is bad, or there is a 
problem with a file.

In Windows 98 run ScanDisk. 
Click Start > Programs > 
Accessories > System Tools > 
ScanDisk.

In Windows 2000, Windows NT, 
and Windows XP, right-click Start, 
click Explore, and select a drive. 
Select File > Properties > Tools. 
Under Error-checking, click 
Check Now.

Diskette drive cannot read 
a diskette.

Diskette is not 
formatted.

Format the diskette.

1. From Windows Explorer select 
the disk (A) drive.

2. Right-click the drive letter and 
select Format.

3. Select the desired options, and 
click Start to begin formatting 
the diskette.

You are using the 
wrong diskette type for 
the drive type.

Check the type of drive that you 
are using and use the correct 
diskette type.

You are reading the 
wrong drive.

Check the drive letter in the path 
statement.

Diskette is damaged. Replace the diskette with a 
new one.

“Invalid system disk” 
message is displayed.

A diskette that does not 
contain the system files 
needed to start your 
computer has been 
inserted in the drive.

When drive activity stops, remove 
the diskette and press the 
Spacebar. The computer should 
start up.

Diskette error has 
occurred.

Restart your computer by pressing 
the power button.

Solving Diskette Problems (Continued)

Problem Cause Solution
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Nonsystem disk/NTLDR 
missing message.

The system is trying 
to start from a 
nonbootable diskette.

Remove the diskette from the
drive.

Cannot Boot to Diskette. Diskette is not 
bootable.

Replace with a bootable diskette.

Diskette boot has been 
disabled in Computer 
Setup.

Run Computer Setup and enable 
diskette boot in Storage > Boot 
Order.

Removable media boot 
has been disabled in 
Computer Setup.

Run Computer Setup and enable 
Removable Media Boot in 
Storage > Storage Options.

Diskette MBR 
validation is enabled.

Run Computer Setup and disable 
Diskette MBR Validation in 
Storage > Storage Options.

Solving Diskette Problems (Continued)

Problem Cause Solution
Troubleshooting Guide 2–11
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Solving Hard Drive Problems

Solving Hard Drive Problems

Problem Cause Solution

Hard drive error occurs. Hard disk has bad 
sectors or has failed.

Use a utility to locate and block 
usage of bad sectors. If necessary, 
reformat the hard disk.

Disk transaction problem. Either the directory 
structure is bad or 
there is a problem with 
a file.

In Windows 98, run ScanDisk. 
Click Start > Programs > 
Accessories > System Tools > 
ScanDisk. 

In Windows 2000, Windows NT, 
and Windows XP, right-click Start, 
click Explore, and select a drive. 
Select File > Properties > Tools. 
Under Error-checking, click 
Check Now.

Drive not found 
(identified).

Cable could be loose. Check cable connections.

The system may not 
have automatically 
recognized a newly 
installed device.

See reconfiguration directions 
in the “Hardware Installation 
Problems” section. If system still 
does not recognize the new device, 
check to see if the device is listed 
within Computer Setup. If it is 
listed, the probable cause is a 
driver problem. If it is not listed, 
the probable cause is a hardware 
problem.

If this is a newly installed drive, 
enter Setup and try adding a POST 
delay under Advanced > 
Power-On.
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Drive not found 
(identified). (continued)

Drive jumper settings 
may be incorrect.

If the drive is a secondary drive that 
has just been installed on the same 
cable as the primary drive, verify 
that the jumpers for both drives are 
set correctly.

SCSI ID may be 
incorrect.

Check SCSI IDs to ensure none 
are duplicated.

Drive’s IDE controller is 
disabled in Computer 
Setup.

Run Computer Setup and enable 
the Primary and Secondary IDE 
controllers in Storage > Storage 
Options.

Drive responds slowly 
immediately after 
power-up.

Run Computer Setup and increase 
the POST Delay in Advanced > 
Power-On Options.

Nonsystem disk/NTLDR 
missing message.

The system is trying to 
start from a diskette 
that is not bootable.

Remove the diskette from the 
diskette drive.

The system is trying to 
start from the hard 
drive but the hard drive 
may have been 
damaged.

Insert a bootable diskette into the 
diskette drive and restart the 
computer.

If the hard drive is still inaccessible 
after booting to a diskette and MBR 
Security is enabled, you may try 
restoring the previously saved MBR 
image. To do so, enter Setup and 
select Security > Restore Master 
Boot Record. (This procedure 
does not apply to Evo™ 
Workstations W6000 or W8000.)

System files missing or 
not properly installed.

Insert a bootable system diskette 
and restart. Verify hard drive is 
partitioned and formatted. Install 
system files for the appropriate 
operating system if necessary.

Solving Hard Drive Problems (Continued)

Problem Cause Solution
Troubleshooting Guide 2–13
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Nonsystem disk/NTLDR 
missing message. 
(continued)

Hard drive boot has 
been disabled in 
Computer Setup.

Run Computer Setup and enable 
the hard drive entry in the 
Storage > Boot Order list.

Second Ultra ATA hard 
drive does not perform 
optimally.

You are using the 
wrong cable for the 
drive type.

Reinstall the second Ultra ATA hard 
drive using an 80-conductor cable. 
The 80-conductor cable is standard 
on select models.

Both slow and fast 
UATA devices are on 
the same data cable.

Change slow UATA devices to a 
separate data cable connected to 
the secondary IDE controller on the 
system board.

Computer will not start. Hard drive is damaged. Observe the beeps and LED lights 
on the keyboard. See Appendix A, 
“POST Error Messages” to 
determine possible causes.

See your Worldwide Limited 
Warranty for details.

Computer seems to be 
locked up.

Program in use has 
stopped responding to 
commands.

Attempt the normal Windows “Turn 
off Computer” procedure. If this 
fails, press the power button for 
four or more seconds to turn off the 
power. To restart your computer, 
press the power button again.

Solving Hard Drive Problems (Continued)

Problem Cause Solution
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Solving Display Problems
If you encounter display problems, see the documentation that came 
with your monitor and to the common causes and solutions listed in 
the following table.

Solving Display Problems

Problem Cause Solution

Blank screen. Monitor is not turned 
on and the monitor light 
is not on.

Turn on the monitor and check that 
the monitor light is on.

The cable connections 
are not correct.

Check the cable connection from 
the monitor to the computer and to 
the electrical outlet.

The energy saver 
feature has been 
enabled.

Press any key or click the mouse 
button and, if set, type your 
password.

The RGB (Red, Green, 
Blue) input switch 
on the monitor is 
incorrectly set.

Set the monitor’s RGB input switch 
to 75 ohms and, if there is a sync 
switch, set it to external.

System ROM is bad; 
system is running in 
Failsafe Boot Block 
mode (indicated by one 
long beep and three 
short beeps).

Reflash the ROM using a ROMPaq 
diskette. See the “Failsafe Boot 
Block ROM” section of the Desktop 
Management Guide for more 
information.

You are using a 
fixed-sync monitor and 
it won’t sync at the 
resolution chosen.

Be sure that the monitor can accept 
the same sweep rate as the 
resolution chosen.

Computer is in Stand 
By mode.

Press the power button to resume 
from Stand By mode.
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Blank screen. (continued) Monitor cable is 
plugged into the wrong 
connector.

If the computer system has both an 
integrated graphics connector and 
an AGP card connector, plug the 
monitor cable into the AGP card 
connector in the expansion card 
area on the back of the computer.

The VGA/BNC 
selector switch is not 
properly set.

Set the selector switch to agree 
with the cable connection.

Monitor does not function 
properly when used with 
energy saver features.

Monitor without energy 
saver capabilities is 
being used with energy 
saver features enabled.

Disable monitor energy saver 
feature.

Graphics colors are 
wrong.

The cabling or monitor 
impedance is incorrect.

1. If you are using BNC cables, 
be sure that the Red, 
Green, and Blue BNC 
cables are connected to 
the corresponding monitor 
connectors.

2. Be sure your monitor’s RGB 
inputs are set to 75 ohms.

Dim characters. The brightness and 
contrast controls are 
not set properly.

Adjust the monitor brightness and 
contrast controls.

Cables are not properly 
connected.

Check that the graphics cable is 
securely connected to the graphics 
card and the monitor.

The RGB switch on the 
back of the monitor is 
incorrectly set.

Set the RGB switch (and sync 
options, if this option is available) 
to 75 ohms, with the sync set to 
external. See the documentation 
included with the monitor.

Solving Display Problems (Continued)

Problem Cause Solution
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Blurry video or requested 
resolution cannot be set.

If the graphics 
controller was 
upgraded, the correct 
graphics drivers may 
not be loaded.

Install the video drivers on the 
diskette included in the upgrade kit.

Monitor is not capable 
of displaying requested 
resolution.

Change requested resolution.

Screen goes blank. You may have a screen 
blanking utility installed 
or energy saver 
features are enabled.

Press any key or type password. 

The picture is broken up, 
or it rolls, jitters, or flashes.

The monitor 
connections may be 
incomplete or the 
monitor may be 
incorrectly adjusted.

1. Be sure the monitor cable is 
securely connected to the 
computer.

2. In a 2-monitor system or if 
another monitor is in close 
proximity, be sure the monitors 
are not interfering with each 
other’s electromagnetic field by 
moving them apart.

3. Fluorescent lights or fans may 
be too close to the monitor.

Monitor overheats. There is not enough 
ventilation space for 
proper airflow.

Leave at least 3 inches (7.6 cm) of 
ventilation space. Be sure there is 
nothing sitting on top of the monitor 
obstructing the air flow.

Solving Display Problems (Continued)

Problem Cause Solution
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Solving Audio Problems
If your computer has audio features and you encounter audio 
problems, see the common causes and solutions listed in the 
following table.

Solving Audio Problems

Problem Cause Solution

Sound does not come 
out of the speaker or 
headphones.

Software volume 
control is turned down.

Double-click the Speaker icon on 
the taskbar, then set volume by 
adjusting the volume slider.

CD-ROM or DVD 
volume control on the 
front of the computer is 
turned down.

Turn the volume control knob on 
front of computer to increase the 
volume.

The external speakers 
are not turned on.

Turn on the external speakers.

External speakers 
plugged into the wrong 
audio jack.

See the sound card documentation 
for proper speaker connection.

Audio cable not 
connected.

Connect audio cable between CD 
or DVD-ROM drive and the system 
board.

Headphones or 
devices connected to 
the line-out connector 
mute the internal 
speaker.

Turn on and use headphones or 
external speakers, if connected, or 
disconnect headphones or external 
speakers.

Volume is muted. 1. From the Control Panel 
program, click Sound, Speech 
and Audio Devices, then click 
Sounds and Audio Devices.

2. Click the Mute check box to 
remove the check mark from 
the box.
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Sound does not come out 
of the speaker or 
headphones. (continued)

Computer is in Stand 
By mode.

Press the power button to resume 
from Stand By mode.

Noise or no sound comes 
out of the speakers or 
headphones.

Computer may not be 
detecting the correct 
speaker/headphone 
type or output or 
analog-to-digital 
auto-sense is not 
engaged.

1. If you are using digital 
speakers that have a stereo 
jack and want the system to 
auto-switch to digital, use a 
stereo-to-mono adapter 
to properly engage the 
auto-sense feature.

2. If a stereo-to-mono adapter 
is not available, use the 
multimedia device properties 
to manually switch the audio 
signal from analog to digital.

3. If the headphones have a 
mono jack, use the multimedia 
device properties to switch the 
system to analog out.

For information on how to change 
the Audio Output Mode, see 
Appendix D, “Setting Up 
Analog/Digital Audio Output.”

Solving Audio Problems (Continued)

Problem Cause Solution
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✎ If you set digital as your Output Mode, the internal speaker and 
external analog speakers will no longer output audio until you switch 
back to an auto-sense or analog mode.

If you set analog as your Output Mode, external digital speakers will 
not function until you change the output mode back to an auto-sense 
or digital mode.

See Appendix D, “Setting up Analog/Digital Audio Output” for 
additional information.
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Solving Printer Problems
If you encounter printer problems, see the documentation that came 
with your printer and to the common causes and solutions listed in the 
following table.

Solving Printer Problems

Problem Cause Solution

Printer will not print. Printer is not turned on 
and online.

Turn the printer on and make sure it 
is online.

The correct printer 
drivers for your 
application are not 
installed.

1. Install the correct printer driver 
for your application.

2. Try printing using the 
DOS command:

DIR C:\ > [printer port]

where [printer port] is the 
address of the printer being 
used. If printer works, reload 
printer driver.

If you are on a network, 
you may not have 
made the connection 
to the printer.

Make the proper network 
connections to the printer.

Printer may have failed. Run printer self-test.

Printer will not turn on. The cables may not be 
connected properly.

Reconnect all cables and check the 
power cord and electrical outlet.

Printer prints garbled 
information.

The correct printer 
driver for your 
application is not 
installed.

Install the correct printer driver for 
your application.

The cables may not be 
connected properly.

Reconnect all cables.

Printer memory may be 
overloaded.

Reset the printer by turning it off for 
one minute, then turn it back on.

Printer is offline. The printer may be out 
of paper.

Check the paper tray and refill it if 
it is empty. Select online.
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Solving Keyboard and Mouse Problems
If you encounter keyboard or mouse problems, see the documentation 
that came with your equipment and to the common causes and 
solutions listed in the following table.

Solving Keyboard Problems

Problem Cause Solution

Keyboard commands and 
typing are not recognized 
by the computer.

Keyboard connector 
is not properly 
connected.

1. On the Windows desktop, 
click Start.

2. Click Shut Down or Turn Off 
Computer. The Turn Off 
Computer dialog box is 
displayed.

3. Select Shut Down or Turn Off.

4. After the shutdown is complete, 
reconnect the keyboard to the 
back of your computer and 
restart the computer.

Program in use has 
stopped responding 
to commands.

Shut down your computer using 
the mouse and then restart the 
computer.

Keyboard needs 
repairs.

See your Worldwide Limited 
Warranty for details.

Cursor will not move using 
the arrow keys on the 
keypad.

The Num Lock key 
may be on.

Press the Num Lock key. The 
Num Lock light should not be on if 
you want to use the arrow keys.
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Solving Mouse Problems

Problem Cause Solution

Mouse does not respond 
to movement or is 
too slow.

Mouse connector is 
not properly plugged 
into the back of the 
computer.

Shut down your computer using the 
keyboard.

1. Press the Ctrl and Esc keys at 
the same time (or press the 
Windows logo key) to display 
the Start menu.

2. Use the up or down arrow key 
to select Shut Down or Turn 
Off Computer and then press 
the Enter key.

3. Use the up or down arrow key 
to select the Shut Down or 
Turn Off option and then press 
the Enter key.

4. After the shutdown is complete, 
plug the mouse connector into 
the back of your computer (or 
the keyboard) and restart your 
computer.

Program in use has 
stopped responding to 
commands.

Shut down the computer using the 
keyboard and then restart the 
computer.

Mouse needs repairs. See your Worldwide Limited 
Warranty booklet for details.

Mouse will only move 
vertically, horizontally, or 
movement is jerky.

Mouse roller ball is 
dirty.

Remove roller ball cover from the 
bottom of the mouse and clean it 
with a mouse cleaning kit available 
from most computer stores.
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Solving Hardware Installation Problems
You may need to reconfigure the computer when you add or remove 
hardware, such as an additional diskette drive. If you install a plug 
and play device, Windows 98, Windows 2000, and Windows XP 
automatically recognize the device and configure the computer. If 
you install a non–plug and play device, you must reconfigure the 
computer after completing installation of the new hardware. In 
Windows 98 or Windows 2000, select the Add New Hardware icon 
in the Control Panel (for Windows XP, use the Add Hardware 
Wizard) and follow the instructions that appear on the screen. To 
reconfigure the computer in Windows NT 4.0 after installing new 
hardware, use the utility provided with the hardware.

Solving Hardware Installation Problems

Problem Cause Solution

A new device is not 
recognized as part of 
the system.

Device is not seated or 
connected properly. 

Ensure that the device is properly 
and securely connected and that 
pins in the connector are not 
bent down.

Cable(s) of new 
external device are 
loose or power cables 
are unplugged.

Ensure that all cables are properly 
and securely connected and that 
pins in the cable or connector are 
not bent down.

Power switch of new 
external device is not 
turned on.

Turn off the computer, turn on the 
external device, then turn on the 
computer to integrate the device 
with the computer system.

When the system 
advised you of 
changes to the 
configuration, you did 
not accept them.

Reboot the computer and follow the 
instructions for accepting the 
changes.
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A new device is not 
recognized as part of the 
system. (continued)

A plug and play board 
may not automatically 
configure when 
added if the default 
configuration conflicts 
with other devices.

Use Windows 98, Windows 2000, 
or Windows XP Device Manager to 
deselect the automatic settings for 
the board and choose a basic 
configuration that doesn’t cause a 
resource conflict. You can also use 
Computer Setup to reconfigure or 
disable devices to resolve the 
resource conflict.

Computer will not start. Wrong memory 
modules were used in 
the upgrade or memory 
modules were installed 
in the wrong location.

1. Review the documentation that 
came with your system to 
determine if you are using the 
correct memory modules and 
to verify the proper installation.

2. Observe the beeps and LED 
lights on the keyboard. See 
Appendix A, “POST Error 
Messages” to determine 
possible causes.

3. If you still cannot resolve the 
issue, contact Compaq 
Technical Support.

Solving Hardware Installation Problems (Continued)

Problem Cause Solution
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Solving Network Problems
Some common causes and solutions for network problems are listed 
in the following table. These guidelines do not discuss the process of 
debugging the network cabling.

Solving Network Problems

Problem Cause Solution

Remote Wakeup feature 
is not functioning.

The Remote Wakeup 
feature is not available 
when using an AUI 
network connection.

Use an RJ-45 network connection.

Remote Wakeup is not 
enabled.

Use the Network control 
application to enable Remote 
Wakeup. See the Desktop 
Management Guide.

Network driver does 
not detect network 
controller.

Network controller is 
disabled.

Run Computer Setup and enable 
network controller.

Incorrect Network Driver. Check the network controller 
documentation for the correct 
driver or obtain the latest driver 
from the manufacturers Web site.

Network status link light 
does not turn on or it 
never flashes.

✎ The network 
status light is 
supposed to flash 
when there is 
network activity.

No active network is 
detected.

Check cabling and network 
equipment for proper connection.

Network controller is not 
set up properly.

Use the Network control 
application to verify that device 
is working properly. See the 
Network Communications Guide.

System is configured for 
AUI connection.

No solution; link LED does not 
apply to AUI connections.

Network driver is not 
properly loaded.

Reinstall network drivers. See the 
Network Communications Guide.
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Network status link light 
does not turn on or 
it never flashes. 
(continued)

System cannot autosense 
the network.

Disable auto-sensing capabilities 
and force the system into the 
correct operating mode. See the 
Network Communications Guide.

Diagnostics reports a 
failure.

The cable is not securely 
connected.

Ensure that the cable is securely 
attached to the network connector 
and that the other end of the cable 
is securely attached to the correct 
device.

The cable is attached to 
the incorrect connector.

Ensure that the cable is attached 
to the correct connector.

There is a problem with 
the cable or a device at 
the other end of the cable.

Ensure that the cable and device 
at the other end are operating 
correctly.

Network controller 
interrupt is shared with 
an expansion board.

Under the Computer Setup 
Advanced menu, change the 
resource settings for the board.

The network controller 
is defective.

Contact your Compaq authorized 
service provider.

Diagnostics passes, but 
the computer does not 
communicate with the 
network.

Network drivers are 
not loaded, or driver 
parameters do not match 
current configuration.

Make sure the network drivers 
are loaded and that the driver 
parameters match the 
configuration of the network 
controller.

Make sure the correct network 
client and protocol is installed.

The network controller 
is not configured for this 
computer.

Select the Network icon in the 
Control Panel and configure the 
network controller.

Network controller 
stopped working when 
an expansion board was 
added to the computer.

Network controller 
interrupt is shared with an 
expansion board.

Under the Computer Setup 
Advanced menu, change the 
resource settings for the board.

Solving Network Problems (Continued)

Problem Cause Solution
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Network controller 
stopped working when 
an expansion board was 
added to the computer. 
(continued)

The network controller 
requires drivers.

Verify that the drivers were not 
accidentally deleted when the 
drivers for a new expansion board 
were installed.

The files containing the 
network drivers are 
corrupted.

Reinstall the network drivers, 
using the Compaq Restore CD.

The expansion board 
installed is a network card 
(NIC) and conflicts with 
the embedded NIC.

Use the Computer Setup to 
disable the embedded NIC.

Network controller stops 
working without 
apparent cause.

The files containing the 
network drivers are 
corrupted.

Reinstall the network drivers, 
using the Compaq Restore CD.

The cable is not securely 
connected.

Ensure that the cable is securely 
attached to the network connector 
and that the other end of the cable 
is securely attached to the correct 
device.

The network controller is 
defective.

Contact your Compaq authorized 
service provider.

New network card will 
not boot.

New network card may 
not be Compaq 
compatible.

Install Compaq-compatible NIC or 
change boot sequence to boot 
from another device.

Cannot connect to 
network server when 
attempting Remote 
System Installation.

The network controller is 
not configured properly.

Run Computer Setup and modify 
the NIC Settings.

System setup utility 
reports unprogrammed 
EEPROM.

Unprogrammed 
EEPROM.

Contact your Compaq authorized 
service provider.

Solving Network Problems (Continued)

Problem Cause Solution
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Solving Processor Problems
If you encounter processor problems, a common cause and solution 
are listed in the following table.

Solving Processor Problems

Problem Cause Solution

Poor performance is 
experienced.

Processor is hot. 1. Make sure the airflow to the 
computer is not blocked.

2. Make sure the fans are 
connected and working 
properly (some fans only 
operate when needed).

3. Make sure the processor 
heatsink is installed properly.

Computer does not 
recognize the second 
processor just installed.

The Hardware 
Abstraction Layer 
(HAL) installed is a 
single-processor HAL.

Install a multi-processor HAL. See 
the instructions provided in the 
processor upgrade option kit.
Troubleshooting Guide 2–29



Troubleshooting Without Diagnostics

177620-006.book  Page 30  Thursday, March 14, 2002  3:16 PM
Solving Memory Problems
If you encounter memory problems, some common causes and 
solutions are listed in the following table.

Ä
CAUTION: Some models support ECC memory and non-ECC memory. 
Other models support only non-ECC memory. For those systems 
that do support ECC memory, Compaq does not support mixing ECC 
and non-ECC memory. Doing so will cause the system to blink the 
Num Lock LED on non-USB keyboards continuously and, if a speaker 
is installed in the system, there will be a short beep followed by 2 long 
beeps. In addition, the system will not boot the operating system.

✎ See the “Interpreting the Diagnostic Lights” section of the Getting 
Started guide to identify other possible memory problems.

Solving Memory Problems

Problem Cause Solution

System won’t boot or does 
not function properly after 
installing additional 
memory modules.

Memory module is not 
the correct type or 
speed grade for the 
system or the new 
memory module is 
not seated properly.

Replace module with the correct 
industry-standard device for your 
computer.

On some models, ECC and 
non-ECC memory modules cannot 
be mixed.

On a single-channel 
Rambus memory 
system, the RIMM 
sockets may be empty.

Check to see that all RIMM sockets 
contain either RIMMs or CRIMMs 
and replace them if needed.

On dual-channel 
Rambus memory 
system, RIMM pairs 
may not be identical.

RIMMs must be added in pairs that 
are identical in speed, number of 
devices, and manufacturer. If the 
RIMM pairs are not identical, 
replace them.
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Out of memory error. Memory configuration 
may not be set up 
correctly.

Use the Device Manager to check 
memory configuration.

You have run out of 
memory to run the 
application.

Check the application 
documentation to determine the 
memory requirements.

Memory count during 
POST is wrong.

The memory modules 
may not be installed 
correctly.

Check that the memory modules 
have been installed correctly and 
that proper modules are used.

Insufficient memory error 
during operation.

Too many Terminate 
and Stay Resident 
programs (TSRs) are 
installed.

Delete any TSRs that you do 
not need.

You have run out of 
memory for your 
application.

Check the memory requirements 
for the application or add more 
memory to the computer.

Unit is on but there is no 
video and, on most 
models, the Power LED is 
flashing Red or Yellow.

Memory is not installed 
correctly and system is 
not booting.

Reinstall memory modules.

Solving Memory Problems (Continued)

Problem Cause Solution
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Solving SCSI Problems
If you encounter SCSI device problems, see the common causes and 
solutions listed in the following table.

Solving SCSI Problems

Problem Cause Solution

System with UATA and 
SCSI drives will not boot 
from SCSI hard drive.

A UATA drive is 
attached, the IDE 
controller is enabled, 
and the Integrated IDE 
controller is listed 
before the SCSI 
adapter in Setup’s 
Storage > Controller 
Order menu.

Under Computer Setup, select 
Storage > Controller Order, and 
move the Integrated IDE controller 
to the end of the list.

System without a UATA 
drive will not boot from a 
SCSI drive.

The SCSI drive is not 
configured correctly.

Ensure that drive cabling and 
jumpers are set correctly. To boot 
a SCSI drive, set the drive ID 
number to 0.

Hard drive boot has 
been disabled in 
Computer Setup.

Under Computer Setup, select 
Storage > Boot Order, and enable 
the Hard Drive entry.

SCSI hard drives are not 
recognized after being 
installed when running 
under Windows NT.

SCSI drivers were 
not installed on the 
system prior to the 
Windows NT 
installation.

Install the SCSI drivers on your 
system first, then install 
Windows NT.

To download SCSI drivers for your 
Compaq system, visit the Compaq 
Web site at www.compaq.com/support

For information on installing SCSI 
drivers, see Appendix E, “Installing 
SCSI Drivers for Windows NT 
Installation.”
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Solving CD-ROM and DVD Problems
If you encounter CD-ROM or DVD problems, see the common 
causes and solutions listed in the following table or to the 
documentation that came with the optional device.

Solving CD-ROM and DVD Problems

Problem Cause Solution

System will not boot from 
CD-ROM or DVD drive.

The CD-ROM or DVD 
boot is not enabled 
through the Computer 
Setup utility.

Run the Computer Setup utility and 
enable booting to removable media 
and verify boot order settings.

Non-bootable CD in 
drive.

Try a bootable CD in the drive.

CD-ROM or DVD devices 
are not detected or driver 
is not loaded.

Drive is not connected 
properly or not properly 
configured.

See the documentation that came 
with the optional device.

Movie will not play in the 
DVD drive.

Movie may be 
regionalized for a 
different country.

See the documentation that came 
with the DVD drive.

Decoder software is 
not installed.

Install decoder software.

Cannot eject compact disc 
(tray-load unit).

Disc not properly 
seated in the drive.

Turn off computer and insert a thin 
metal rod into the emergency eject 
hole and push firmly. Slowly pull 
the tray out from the drive until the 
tray is fully extended, then remove 
the disc.

CD-ROM, CD-RW, 
DVD-ROM, or DVD-R/RW 
drive cannot read a disc or 
takes too long to start.

CD has been inserted 
upside down.

Re-insert the CD with the label 
facing up.
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CD-ROM, CD-RW, 
DVD-ROM, or DVD-R/RW 
drive cannot read a disc or 
takes too long to start. 
(continued)

The DVD-ROM drive 
takes longer to start 
because it has to 
determine the type of 
media played, such as 
audio or video.

Wait at least 30 seconds to let the 
DVD-ROM drive determine the type 
of media being played. If the disc 
still does not start, read the other 
solutions listed for this topic.

CD or DVD disc is dirty. Clean CD or DVD with a CD 
cleaning kit, available from most 
computer stores.

Windows does not 
detect the CD-ROM or 
DVD-ROM drive.

1. Use Device Manager to 
remove or uninstall the device 
in question.

2. Restart your computer and let 
Windows detect the CD or DVD 
driver.

Recording audio CDs is 
difficult or impossible.

Wrong or poor quality 
media type.

1. Try using a slower speed when 
recording.

2. Verify that you are using the 
correct media for the drive.

3. Try a different brand of media. 
Quality varies widely between 
manufacturers.

Solving CD-ROM and DVD Problems

Problem Cause Solution
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Solving Software Problems
Most software problems occur as a result of the following:

■ The application was not installed or configured correctly.

■ There is insufficient memory available to run the application.

■ There is a conflict between applications.

■ Be sure that all the needed device drivers have been installed.

■ If you have installed an operating system other than the 
factory-installed operating system, check to be sure it is 
supported on your system.

Where available, run the Compaq Configuration Record Utility to 
determine if any changes have been made to the software which may 
be causing a problem. See the Desktop Management Guide on the 
Documentation Library CD for more information.

If you encounter software installation problems using a SCSI hard 
drive, see the applicable solutions listed in the following table:

Solving Software Problems

Problem Cause Solution

Windows NT is not 
installing properly on a 
SCSI hard drive.

SCSI drivers were 
not installed on the 
system prior to the 
Windows NT 
installation.

Install the SCSI drivers on your 
system first, then install 
Windows NT.

To download SCSI drivers for your 
Compaq system, visit the Compaq 
Web site at www.compaq.com/support

For information on installing SCSI 
drivers, see Appendix E, “Installing 
SCSI Drivers for Windows NT 
Installation.”
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Contacting Compaq Customer Support
For help and service, contact your Compaq authorized reseller or 
dealer. To locate a Compaq reseller or dealer near you, visit the 
Compaq Web site at www.compaq.com.

✎ If you take your computer to a Compaq authorized reseller, dealer, or 
service provider for service, remember to provide the setup and 
power-on passwords, if they are set.

Computer will not start. System files may be 
damaged.

Observe the beeps and LED lights 
on the keyboard. See Appendix A, 
“POST Error Messages” to 
determine possible causes.

See your Compaq Restore kit or 
your Worldwide Limited Warranty 
for details.

“Illegal Operation has 
Occurred” error message 
is displayed.

Software being used is 
not Microsoft-certified 
for your version of 
Windows.

Verify that the software is certified 
by Microsoft for your version of 
Windows (see program packaging 
for this information).

Configuration files are 
corrupt.

If possible, save all data, close all 
programs, and restart your 
computer.

Solving Software Problems

Problem Cause Solution
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A
Post Error Messages

This appendix lists the error codes, error messages, and the various 
indicator light and audible sequences that you may encounter during 
the Power-On Self-Test (POST) or computer restart, the probable 
source of the problem, and what steps you can take to resolve the 
error condition.

POST Numeric Codes and Text Messages
This section covers those POST errors that have numeric codes 
associated with them. The section also includes some text messages 
that may be encountered during POST.

Numeric Codes and Text Messages

Code/Message Beeps Probable Cause Recommended Action

101-Option ROM 
Error

1L, 1S* System ROM 
checksum.

1. Verify the correct ROM.

2. Flash the ROM if needed.

3. If an expansion board was 
recently added, remove it 
and see if the problem 
remains.

4. Clear CMOS.

5. If the message disappears, 
there may be a problem 
with the expansion card.

6. Replace the system board.

*L = Long, S = Short
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102-System 
Board Failure

None DMA, timers, and so 
forth.

1. Clear CMOS.

2. Remove expansion boards.

3. Replace the system board.

103-System 
Board Failure

None DMA, timers, and so 
forth.

1. Clear CMOS.

2. Remove expansion boards.

3. Replace the system board.

150-SafePost 
Active

None A PCI expansion card 
is not responding.

1. Restart the computer.

2. Disable SafePost.

3. If the expansion card 
does not respond, replace 
the card.

162-System 
Options Not Set

2S* Configuration incorrect.

RTC (real-time clock) 
battery may need to 
be replaced. Battery 
life is approximately 
3–5 years.

Run Computer Setup.

Reset the date and time under 
Control Panel. If the problem 
persists, replace the RTC 
battery. See the Hardware 
Reference Guide for 
instructions on installing a new 
battery, or contact your Compaq 
authorized dealer or reseller for 
RTC battery replacement.

*L = Long, S = Short

Numeric Codes and Text Messages

Code/Message Beeps Probable Cause Recommended Action
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163-Time & Date 
Not Set

2S* Invalid time or date in 
configuration memory.

RTC (real-time clock) 
battery may need to 
be replaced. Battery 
life is approximately 
3–5 years.

Reset the date and time under 
Control Panel (Computer 
Setup can also be used to 
update the RTC date and time). 
If the problem persists, replace 
the RTC battery. See the 
Hardware Reference Guide for 
instructions on installing a new 
battery, or contact your Compaq 
authorized dealer or reseller for 
RTC battery replacement.

CMOS jumper may not 
be properly installed.

Check for proper placement 
of the CMOS jumper if 
applicable.

164-Memory Size 
Error

2S* Memory configuration 
incorrect.

1. Run Computer Setup or 
Microsoft Windows utilities.

2. Make sure your memory 
module(s) are installed 
properly.

3. If third party memory has 
been added, test using 
Compaq-only memory.

4. Verify proper memory 
module type.

183-Invalid 
Processor 
Jumper Setting

2S* System board jumper 
improperly set.

Reset system board jumpers 
to match processor and bus 
speeds (select models).

*L = Long, S = Short

Numeric Codes and Text Messages

Code/Message Beeps Probable Cause Recommended Action
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201-Memory 
Error

None RAM failure. 1. Run Computer Setup or 
Windows utilities.

2. Ensure memory and 
continuity modules are 
installed correctly.

3. Verify proper memory 
module type.

4. Remove and replace the 
memory module(s) one 
at a time to isolate faulty 
module.

5. Replace faulty memory 
module(s).

6. If error persists after 
replacing memory modules, 
replace the system board.

202-Memory 
Type Mismatch

None Memory modules do 
not match each other.

Replace memory modules with 
matched sets.

207-ECC 
Corrected Single 
Bit Errors in 
Memory Module 
Socket(s) y,y, …

2S* Single Bit ECC error. 1. Verify proper memory 
module type.

2. Try another memory socket.

3. Replace memory module if 
problem persists.

212-Failed 
Processor

None Processor has failed to 
initialize.

1. Reseat the processor in its 
socket.

2. If the processor does not 
respond, replace it.

*L = Long, S = Short

Numeric Codes and Text Messages

Code/Message Beeps Probable Cause Recommended Action
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213-Incompatible 
Memory Module 
in Memory 
Socket(s) X, X, ...

2S* A memory module 
in memory socket 
identified in the error 
message is missing 
critical SPD 
information, or is 
incompatible with the 
chipset.

1. Verify proper memory 
module type.

2. Try another memory
socket.

3. Replace DIMM with a 
module conforming to 
the SPD standard.

214-Memory 
Device Failure. 
Error code: XX, 
Memory Module 
Socket(s): XX

None A specific error has 
occurred in a memory 
device installed in the 
identified socket.

1. Verify proper memory 
module type.

2. Try another memory
socket.

3. Replace memory module if 
problem persists.

215-RIMM 
Configuration 
Error

None RIMMs not properly 
installed.

All RIMM sockets must be 
populated with either RIMMs 
or CRIMMs starting with 
socket 1. On dual channel 
systems, there must be a 
RIMM in each channel. See 
the Hardware Reference Guide 
for a list of RIMM installation 
guidelines.

301-Keyboard 
Error

None Keyboard failure. 1. Reconnect keyboard with 
computer turned off.

2. Check connector for bent or 
missing pins.

3. Ensure that none of the 
keys are depressed.

4. Replace keyboard.

*L = Long, S = Short

Numeric Codes and Text Messages

Code/Message Beeps Probable Cause Recommended Action
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303-Keyboard 
Controller Error

None I/O board keyboard 
controller.

1. Reconnect keyboard with 
computer turned off.

2. Replace the system board.

304-Keyboard or 
System Unit Error

None Keyboard failure. 1. Reconnect the keyboard 
with computer turned off.

2. Ensure that none of the 
keys are depressed.

3. Replace the keyboard.

4. Replace the system board.

401-Parallel 
Port 1 Address 
Assignment 
Conflict

2S* IRQ address conflicts 
with another device.

Reset the IRQ.

402-Monochrome 
Adapter Failure

1L,2S* Monochrome display 
controller.

Replace the Monochrome 
display controller.

403-Parallel Port 
3 Address 
Conflict Detected

2S* IRQ address conflicts 
with another device.

Reset the IRQ.

404-Parallel Port 
Address Conflict 
Detected

2S* Both external and 
internal ports are 
assigned to 
parallel port X.

1. Remove any parallel port 
expansion cards.

2. Clear CMOS.

3. Reconfigure card 
resources and/or run 
Computer Setup.

410-Audio 
Interrupt Conflict

2S* IRQ address conflicts 
with another device.

Reset the IRQ.

411-Network 
Interface Card 
Interrupt Conflict

2S* IRQ address conflicts 
with another device.

Reset the IRQ.

*L = Long, S = Short

Numeric Codes and Text Messages

Code/Message Beeps Probable Cause Recommended Action
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501-Display 
Adapter Failure

1L, 2S* Graphics display 
controller.

1. Reseat the graphics card 
(if applicable).

2. Clear CMOS.

3. Verify monitor is attached 
and turned on.

4. Replace the graphics 
controller.

510-Splash 
Screen image 
corrupted

None Splash Screen image 
has errors.

Install latest version of 
ROMPaq to restore image.

511-CPU, Rear, 
or Front Fan not 
detected

None Fan is not connected or 
may have 
malfunctioned.

1. Reseat fan cable.

2. Replace the fan.

601-Diskette 
Controller Error

None Diskette controller 
circuitry or floppy drive 
circuitry incorrect.

1. Run Computer Setup.

2. Check and/or replace 
cables.

3. Clear CMOS.

4. Replace diskette drive.

5. Replace the system board.

602-Diskette 
Boot Record 
Error

None Diskette in Drive A not 
bootable.

Replace the diskette.

*L = Long, S = Short 

Numeric Codes and Text Messages

Code/Message Beeps Probable Cause Recommended Action
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605-Diskette 
Drive Type Error

2S* Mismatch in drive type. 1. Run Computer Setup or 
Microsoft Windows NT, 
Microsoft Windows 95, or 
Microsoft Windows 98 
utilities.

2. Disconnect any other 
diskette controller devices 
(tape drives).

3. Clear CMOS.

610-External 
Storage Device 
Failure

None External tape drive not 
connected.

Reinstall tape drive or press 
F1 and allow system to 
reconfigure without the drive.

611-Primary 
Floppy Port 
Address 
Assignment 
Conflict

2S* Configuration error. Run Computer Setup 
or Windows NT or 
Windows utilities.

612-Secondary 
Floppy Port 
Address 
Assignment 
Conflict

2S* Configuration error. 1. Run Computer Setup.

2. Remove expansion cards.

3. Clear CMOS.

660-Display 
cache is detected 
unreliable

None Integrated graphics 
controller display 
cache is not working 
properly and will be 
disabled.

Replace system board if 
minimal graphics degrading 
is an issue.

912-Computer 
Cover Has Been 
Removed Since 
Last System 
Startup

None No action required.

*L = Long, S = Short

Numeric Codes and Text Messages

Code/Message Beeps Probable Cause Recommended Action
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914-Hood Lock 
Coil is not 
Connected

None Smart Cover Lock 
mechanism is missing 
or not connected.

1. Reconnect or replace 
hood locking mechanism.

2. Reseat or replace hood 
locking mechanism cable.

916-Thermal 
Sensor from 
Processor 
Heatsink is not 
Connected

None Processor heatsink 
cable not connected to 
system board.

Reseat or replace the 
processor heatsink cable 
going to the system board.

917-Expansion 
Riser not 
Detected

None Riser board not seated 
or not installed.

Install riser board if missing or 
remove and reseat to ensure 
good connection.

1151-Serial Port 
1 Address 
Conflict Detected

2S* Both external and 
internal serial ports are 
assigned to COM1.

1. Remove any serial port 
expansion cards.

2. Clear CMOS.

3. Reconfigure card 
resources and/or run 
Computer Setup or 
Windows utilities.

1152-Serial 
Port 2 Address 
Conflict Detected

2S* Both external and 
internal serial ports are 
assigned to COM2.

1. Remove any serial port 
expansion cards.

2. Clear CMOS.

3. Reconfigure card 
resources and/or run 
Computer Setup or 
Windows utilities.

*L = Long, S = Short

Numeric Codes and Text Messages

Code/Message Beeps Probable Cause Recommended Action
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1155-Serial Port 
Address Conflict 
Detected

2S* Both external and 
internal serial ports are 
assigned to same IRQ.

1. Remove any serial port 
expansion cards.

2. Clear CMOS.

3. Reconfigure card resources 
and/or run Computer Setup 
or Windows utilities.

1201-System 
Audio Address 
Conflict Detected

2S* Device IRQ address 
conflicts with another 
device.

Reset the IRQ.

1202-MIDI Port 
Address Conflict 
Detected

2S* Device IRQ address 
conflicts with another 
device.

Reset the IRQ.

1203-Game Port 
Address Conflict 
Detected

2S* Device IRQ address 
conflicts with another 
device.

Reset the IRQ.

1611-Fan failure 
detected

None Chassis fan not 
connected to the 
system board.

1. Reconnect the fan.

2. Replace the fan.

3. Replace the system board.

1720-SMART 
Hard Drive 
Detects Imminent 
Failure

None Hard drive is about 
to fail. (Some hard 
drives have a firmware 
patch that will fix an 
erroneous error 
message.)

1. Determine if hard drive 
is giving correct error 
message. Run the Drive 
Protection System test if 
available.

2. Apply firmware patch 
if applicable. (See 
www.compaq.com/
support/techpubs/
customer_advisories.)

3. Back up contents and 
replace hard drive.

*L = Long, S = Short

Numeric Codes and Text Messages

Code/Message Beeps Probable Cause Recommended Action
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1721-SMART 
SCSI Hard Drive 
Detects Imminent 
Failure

None Hard drive is about to 
fail. (Some hard drives 
have a firmware patch 
that will fix an 
erroneous error 
message).

1. Determine if hard drive 
is giving correct error 
message.

2. Apply firmware patch if 
applicable.

3. Back up contents and 
replace hard drive.

1782-Disk 
Controller Failure

None Hard drive circuitry 
error.

1. Run Computer Setup.

2. Clear CMOS.

3. Check cable seating/jumper 
settings.

4. Run hard drive diagnostics.

5. Disconnect additional 
drives.

6. Run the Drive Protection 
System test if available.

7. Check www.compaq.com/
support/techpubs/
customer_advisories/ 
for possible changes when 
using Windows NT 4.0 
Service Pack 4.

8. Replace the hard drive.

9. Replace the system board.

1800-Tempera-
ture Alert

None Internal temperature 
exceeds specification.

1. Check that computer air 
vents are not blocked and 
cooling fan is running.

2. Verify processor speed 
selection.

3. Replace the processor.

4. Replace the system board.

Numeric Codes and Text Messages

Code/Message Beeps Probable Cause Recommended Action
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1801 None Processor is not 
supported by 
ROM BIOS.

Upgrade BIOS to proper 
version.

1998-Master 
Boot Record has 
been lost.

1L, 2S* The previously saved 
copy of the MBR has 
been corrupted.

Run Computer Setup and 
save the MBR of the current 
bootable disk.

1999-Master 
Boot Record has 
changed.

1L* The current MBR 
does not match the 
previously saved copy 
of the MBR.

Use extreme caution. The 
MBR may have been updated 
due to normal disk maintenance 
activities (disk manager, fdisk, 
or format). Replacing the 
previously saved MBR in such 
situations can cause data loss. 
If you are certain the MBR 
change is unintentional and 
undesired (e.g. due to a virus), 
then run Computer Setup and 
restore the previously saved 
MBR copy. Otherwise, run 
Computer Setup and either 
disabled MBR security or 
save the MBR of the current 
bootable disk.

2000-Master 
Boot Record 
Hard Drive has 
changed.

1L, 2S* The current bootable 
hard drive is not the 
same as the one that 
was present when 
MBR Security was 
enabled.

Run Computer Setup and 
either disable MBR security or 
save the MBR of the current 
bootable disk.

*L = Long, S = Short

Numeric Codes and Text Messages

Code/Message Beeps Probable Cause Recommended Action
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Invalid Electronic 
Serial Number.

None Electronic serial 
number has become 
corrupted.

1. Run Computer Setup. If 
Setup already has data 
in the field or will not allow 
the serial number to be 
entered, download from 
www.compaq.com and run 
SP5572.EXE (SNZERO.EXE).

2. Run Computer Setup and 
try to enter serial number 
under Security, System ID, 
then save changes.

ECC Multiple Bit 
Error Detected in 
Memory Module.

None Chipset has detected 
more than one bad bit 
in a 64bit quadword of 
the memory array.

Replace the memory module.

Parity Check 2. None Parity RAM failure. Run Computer Setup and 
Diagnostic Utilities.

Numeric Codes and Text Messages

Code/Message Beeps Probable Cause Recommended Action
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POST Diagnostic Keyboard LEDs, Front Panel LEDs 
and Audible Codes

This section covers the keyboard and front panel LED codes as well 
as the audible codes that may occur during POST that do not 
necessarily have an error code or text message associated with them.

✎ If your system is equipped with a Universal Serial Bus (USB) 
keyboard, you may hear the beep sequences for some of the keyboard 
light error codes, but you may not see the flashing keyboard lights.

Diagnostic Keyboard LEDS, Front Panel LEDs and Audible Codes

Activity Beeps Probable Cause Recommended Action

Audible 1L, 3S* System ROM is bad; 
system is running 
in Failsafe Boot 
Block mode.

Reflash the ROM using a 
ROMPaq diskette. See the 
“Failsafe Boot Block ROM” 
section of the Desktop 
Management Guide.

Flashing Caps 
Lock LED on 
Keyboard.

1L, 2S* Graphics controller not 
present or incorrectly 
initialized.

1. Clear CMOS.

2. If graphics card has been 
added, remove and 
reseat.

3. Reseat riser board if 
applicable.

*L = Long, S = Short
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Flashing Num 
Lock LED on 
Keyboard (on 
select models.)

1S, 2L* System memory not 
present.

1. Check memory module 
(see the relevant section 
of the Hardware 
Reference Guide).

2. Remove and reseat 
memory module.

3. See the “Solving Memory 
Problems” section of this 
guide.

ÄCAUTION: Some models support ECC memory and non-ECC memory. Other models 
support only non-ECC memory. For those systems that do support ECC memory, 
Compaq does not support mixing ECC and non-ECC memory. In addition, the 
system will not boot the operating system.

Num Lock LED On 
(keyboard).

None Failed Boot Block. Reflash the ROM using a 
ROMPaq diskette. See the 
“Failsafe Boot Block ROM” 
section of the Desktop 
Management Guide.

Flashing Scroll 
Lock LED on 
keyboard (on 
select models.)

2L, 1S* System board hardware 
failure (prior to 
graphics).

Replace system board.

Green Power 
LED flashes
1x / second.

None Computer in normal 
Suspend mode.

None

Green Power 
LED On.

None Computer on. None

*L = Long, S = Short

Diagnostic Keyboard LEDS, Front Panel LEDs and Audible Codes

Activity Beeps Probable Cause Recommended Action
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Red or Yellow 
Power LED 
flashes every 
2 seconds (on 
select models.)

None Power supply 
overloaded.

1. Push in power button. 
LED should be green.

2. Remove all AC power 
from computer, wait 
30 seconds, then apply 
power.

3. Remove load from power 
supply by removing 
options one at a time 
until computer runs.

4. Check for damage to 
system board.

5. Replace system board.

6. Replace power supply.

Flashing Power 
and Hard Drive 
Green LEDs.

None Unseated riser board. 1. Remove riser board.

2. Wipe connector.

3. Reinstall riser board (see 
the Hardware Reference 
Guide for directions on 
removing the riser board).

Diagnostic Keyboard LEDS, Front Panel LEDs and Audible Codes

Activity Beeps Probable Cause Recommended Action
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Yellow or Green 
Power LED 
flashes every 
second (on select 
models.)

None System memory error. 1. Check memory module 
(see the relevant section 
of the Hardware 
Reference Guide).

2. Remove and reseat 
memory module.

3. See the “Solving Memory 
Problems” section of this 
guide.

Red or Yellow 
Power LED On

None Processor unseated. Reseat processor in system 
board.

Red or Yellow 
Power LED is:

1. Flashing four 
times per 
second, Or

2. Flashing two 
times one 
second apart, 
followed by a 
two second 
pause, Or

3. Not flashing.

None Computer overheated. 1. Install computer cover 
or access panel if 
necessary.

2. Ensure that computer air 
vents are not blocked and 
internal fan is running.

Diagnostic Keyboard LEDS, Front Panel LEDs and Audible Codes

Activity Beeps Probable Cause Recommended Action
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B
Password Security and Resetting CMOS

This computer supports security password features, which can be 
established through the Computer Setup Utilities menu.

This computer supports two security password features that are 
established through the Computer Setup Utilities menu: setup 
password and power-on password. When you establish only a setup 
password, any user can access all the information on the computer 
except Computer Setup. When you establish only a power-on 
password, the power-on password is required to access Computer 
Setup and any other information on the computer. When you establish 
both passwords, only the setup password will give you access to 
Computer Setup.

When both passwords are set, the setup password can also be used 
in place of the power-on password as an override to log into the 
computer. This is a useful feature for a network administrator.

If you forget the password for your computer, there are two methods 
for clearing that password so you may gain access to the information 
on the computer:

■ Resetting the password jumper

■ Using the Clear CMOS button

Ä
CAUTION: Pushing the CMOS button will reset CMOS values to factory 
defaults and will erase any customized information including passwords, 
asset numbers, and special settings. It is important to back up the 
computer CMOS settings before resetting them in case they are needed 
later. Back up is easily done through Computer Setup. See the 
Computer Setup (F10) Utility Guide for information on backing up your 
CMOS settings.
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Resetting the Password Jumper
To disable the power-on or setup password features, or to clear the 
power-on or setup passwords, complete the following steps:

1. Shut down the operating system properly, then turn off the 
computer and any external devices, and disconnect the power 
cord from the power outlet.

2. Disconnect the keyboard, monitor, and any other external devices 
connected to the computer.

Å
WARNING: To reduce the risk of personal injury from electrical shock 
and/or hot surfaces, be sure to disconnect the power cord from the wall 
outlet, and allow the internal system components to cool before 
touching.

Ä
CAUTION: When the computer is plugged in, the power supply always 
has voltage applied to the system board even when the unit is turned 
off. Failure to disconnect the power cord can result in damage to the 
system.

Ä
CAUTION: Static electricity can damage the electronic components 
of the computer or optional equipment. Before beginning these 
procedures, ensure that you are discharged of static electricity by briefly 
touching a grounded metal object. See the Safety & Regulatory 
Information guide for more information.

3. Remove the computer cover or access panel.

4. Locate the header and jumper.

✎ On most system boards, the header is labeled E49 or P49.

✎ For assistance locating the password jumper and other system board 
components, see the Illustrated Parts Map (IPM) for your particular 
system.

5. Remove the jumper from pins 1 and 2. Place the jumper over 
pin 2 only, in order to avoid losing it.
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6. Replace the computer cover or access panel.

7. Reconnect the external equipment.

8. Plug in the computer and turn on power. Allow the operating 
system to start. This clears the current passwords and disables the 
password features.

9. To re-enable the password features, repeat steps 1-4, then replace 
the jumper on pins 1 and 2.

10. Repeat steps 6-8, then establish new passwords. See the 
Computer Setup (F10) Utility Guide for Computer Setup 
instructions.

Clearing and Resetting the CMOS
The computer’s configuration memory (CMOS) stores password 
information and information about the computer’s configuration.

Using the CMOS Button

1. Turn off the computer and any external devices, and disconnect 
the power cord from the power outlet.

2. Disconnect the keyboard, monitor, and any other external 
equipment connected to the computer.

Å
WARNING: To reduce the risk of personal injury from electrical shock 
and/or hot surfaces, be sure to disconnect the power cord from the wall 
outlet, and allow the internal system components to cool before 
touching.

Ä
CAUTION: When the computer is plugged in, the power supply always 
has voltage applied to the system board even when the unit is turned 
off. Failure to disconnect the power cord can result in damage to the 
system.
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Ä
CAUTION: Static electricity can damage the electronic components 
of the computer or optional equipment. Before beginning these 
procedures, ensure that you are discharged of static electricity by briefly 
touching a grounded metal object. See the Safety & Regulatory 
Information Guide for more information.

3. Remove the computer cover or access panel.

Ä
CAUTION: Pushing the CMOS button will reset CMOS values to factory 
defaults and will erase any customized information including passwords, 
asset numbers, and special settings. It is important to back up the 
computer CMOS settings before resetting them in case they are needed 
later. Back up is easily done through Computer Setup. See the 
Computer Setup (F10) Utility Guide for information on backing up your 
CMOS settings.

4. Locate, press, and hold the CMOS button in for 5 seconds.

CMOS button
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5. Replace the computer cover or access panel.

✎ For assistance locating the CMOS button and other system board 
components, see the Illustrated Parts Map (IPM) for your particular 
system.

6. Reconnect the external devices.

7. Plug in the computer and turn on power.

✎ You will need to reset your passwords and any special system setups 
along with the date and time.

See the Desktop Management Guide for further instructions on 
reestablishing passwords. For instructions on Computer Setup, see the 
Computer Setup (F10) Utility Guide.

Using Computer Setup to Reset CMOS

To reset CMOS, you must first access the Computer Setup Utilities 
menu.

When the Computer Setup message appears in the lower-right corner 
of the screen, press the F10 key. Press Enter to bypass the title screen, 
if necessary.

✎ If you do not press the F10 key while the message is displayed, you 
must turn the computer off, then on again, to access the utility.

A choice of five headings appears in the Computer Setup Utilities 
menu: File, Storage, Security, Power, and Advanced.

To reset CMOS to the factory default settings first set time and date, 
then use the arrow keys or the Tab key to select File > Set Defaults 
and Exit. This resets the soft settings that include boot sequence order 
and other factory settings. It will not, however, force hardware 
rediscovery.

See the Desktop Management Guide for further instructions on 
reestablishing passwords. For instructions on Computer Setup, see the 
Computer Setup (F10) Utility Guide.
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C
Drive Protection System (DPS)

Introducing the Drive Protection System
The Compaq Drive Protection System (DPS) is a diagnostic tool 
built into the hard drives installed in select Evo Desktops and Evo 
Workstations. DPS is designed to help diagnose problems that might 
result in unwarranted hard drive replacement.

When these systems are built, each installed hard drive is tested using 
DPS, and a permanent record of key information is written onto the 
drive. Each time DPS is run, test results are written to the hard drive. 
Your service provider can use this information to help diagnose 
conditions that caused you to run the DPS software.

Running DPS will not affect any programs or data stored on the hard 
drive. The test resides in the hard drive firmware and can be executed 
even if the computer will not boot to an operating system. The time 
required to execute the test depends on the manufacturer and size of 
the hard drive; in most cases, the test will take approximately two 
minutes per gigabyte.

Use DPS when you suspect a hard drive problem. If the computer 
reports a SMART Hard Drive Detect Imminent Failure message, there 
is no need to run DPS; instead, back up the information on the hard 
drive and contact your Compaq service provider for a replacement 
hard drive.
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Accessing DPS Through Compaq Diagnostics for Windows

To access DPS through Compaq Diagnostics for Windows, perform 
the following steps:

1. Turn on the computer and select My Computer > Control 
Panel > Compaq Diagnostics.

A choice of five possible headings appears in the Diagnostics 
screen: Overview, Test, Status, Log, and Error.

2. Select Test > Type of Test.

A choice of three tests appear: Quick Test, Complete Test, and 
Custom Test.

3. Select Custom Test.

A choice of two test modes is offered: Interactive Mode and 
Unattended Mode.

4. Select Interactive Test > Storage > Hard Drives.

5. Select the specific drives to be tested > Drive Protection System 
Test > Begin Testing.

When the test has been completed, one of three messages will be 
displayed for each of the drives tested:

■ Test Succeeded. Completion Code 0.

■ Test Aborted. Completion Code 1 or 2.

■ Test Failed. Drive Replacement Recommended. Completion 
Code 3 through 14.

If the test failed, the completion code should be recorded and reported 
to your service provider for help in diagnosing the computer problem.
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Accessing DPS Through Computer Setup

When the computer does not power on properly you should use 
Computer Setup to access the DPS program. To access DPS, perform 
the following steps:

1. Turn on or restart the computer.

2. When the F10 Setup message appears in the lower-right corner of 
the screen, press the F10 key.

✎ If you do not press the F10 key while the message is displayed, you 
must turn the computer off, then on again, to access the utility.

A choice of five headings appears in the Computer Setup Utilities 
menu: File, Storage, Security, Power, and Advanced.

3. Select Storage > IDE DPS Self-Test.

The screen will display the list of DPS-capable hard drives that 
are installed on the computer.

✎ If no DPS capable hard drives are installed, the IDE DPS Self-Test 
option will not appear on the screen.

4. Select the hard drive to be tested and follow the screen prompts to 
complete the testing process.

When the test has been completed, one of three messages will be 
displayed:

■ Test Succeeded. Completion Code 0.

■ Test Aborted. Completion Code 1 or 2.

■ Test Failed. Drive Replacement Recommended. Completion 
Code 3 through 14.

If the test failed, the completion code should be recorded and reported 
to your service provider for help in diagnosing the computer problem.
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D
Setting up Analog/Digital Audio Output

Some computers or workstations may have an integrated audio 
solution that supports analog or digital external stereo speakers. 
These systems are capable of auto-sensing the speaker type and 
outputting the correct signal. To manually change between analog, 
digital and auto-sense, complete the following set of procedures 
based on your operating system.

✎ If you set digital as your Output Mode, the internal speaker and 
external analog speakers will no longer output audio until you switch 
back to an auto-sense or analog mode. If you set analog as your 
Output Mode, external digital speakers will not function until you 
change the output mode back to an auto-sense or digital mode.

Microsoft Windows 98 and Microsoft Windows 2000

1. Click Start > Settings > Control Panel and double-click the 
System icon to open the System Properties panel.

2. Select Device Manager from the System Properties panel.

3. Click the “+” next to the Sound, Video and Game Controllers 
to expand it.

4. For Windows 98, go to step 5.
For Windows 2000, go to step 6.

5. In Windows 98 highlight the appropriate audio device, then click 
Properties to open its Properties panel.

Continue with step 7.

6. In Windows 2000, double-click the appropriate audio device to 
open its Properties panel.
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7. In the Configuration area of the Settings tab, change the Output 
Mode to the desired setting.

8. Click OK to close the Properties panel.

9. Close the System Properties panel.

10. Close the Control Panel.

Microsoft Windows NT 4.0

1. Click Start > Settings > Control Panel and double-click the 
Multimedia icon to open the Multimedia Properties panel.

2. Select the Device tab at the top of the panel.

3. Click the “+” next to the “Audio Devices” to expand it.

4. Click the appropriate audio device to highlight it.

5. Click Properties to open the Properties panel and click Settings.

6. Change the Output Mode to the desired setting.

7. Click OK to close the Properties panel.

8. Close the Multimedia Properties panel.

9. Close the Control Panel.

Microsoft Windows XP

1. Click Start > Control Panel and then double-click the Sounds, 
Speech, and Audio Devices icon.

2. Select the Hardware tab.

3. Highlight the appropriate audio device.

4. Click Properties to open up the Device Properties panel.

5. Click the Properties tab.

6. Click the “+” next to “Audio Devices” to expand it.

7. Highlight the appropriate driver by clicking it.
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8. Click Properties.

9. Click Settings.

10. Change the Output Mode to the desired setting.

11. Click OK to close the Properties panel.

12. Close the Control Panel.
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E
Installing SCSI Drivers for Windows NT

Installation

The information in this appendix applies to Evo Workstations only.

✎ The following information does not apply if you are completing the 
initial setup of the preinstalled software or if you are restoring your 
preinstalled image from the Compaq Restore CD.

If your workstation has a SCSI hard drive installed and you are 
installing Microsoft Windows NT from a retail Microsoft Windows 
NT Workstation CD or directly from the Compaq Operating System 
CD, you must complete the following steps.

On a secondary system:

1. Go to the following Compaq Web site:

www.compaq.com/support/files/workstations/us/index.html

2. Under locate by computer, select your workstation model and 
Microsoft Windows NT 4.0, then click Go.

3. Under Storage, choose Family Manager Set Drivers for your 
specific SCSI controller. Visit the following Compaq Web site if 
you are not sure which controller shipped with your system:

www.compaq.com/products/quickspecs/productbulletin.html

4. Download the Softpaq to a temporary directory, then execute it to 
create a diskette with the required SCSI drivers.
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On your primary system:

1. Place the OS CD in the CD-ROM drive and boot the system.

2. When the message “Setup is inspecting your computer’s 
hardware configuration” display, press the F6 key. The system 
will prompt you for the SCSI drivers.

3. Insert the diskette containing the drivers. When prompted, 
choose S from the list to specify an additional device.

4. Choose Other from the list. When prompted, select your SCSI 
controller.

5. Press the Enter key to continue the installation.

After the drivers are installed, install Windows NT on your SCSI hard 
drive. Remember to install the latest Service Pack.

✎ For more information, visit the Compaq Web site at:

www.compaq.com/support/workstations

Click on your workstation model, then look for a Customer Advisory 
related to the issue.
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